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Operational Overview
InterLOGIC dbc/OS Console Startup
From the Windows Desktop, double click the dbcOS Engineering Console icon to start the 
InterLOGIC dbc/OS Engineering Console.  

InterLOGIC Engineering Console 

Screen 1 is the main screen that provides access to the graphic windows, system views, system tools 
and the main pull-down menu bar.  If the Toolbar on the left of the screen is not displayed, click 
Window on the main menu and then Tools.

Screen 1
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Operational Overview
Login
Click on the Tools button at the lower left side of Screen 1 to display the tool bar shown in 
Screen 2.  Now click the Logon button to logon to the system.  Enter  your user number, user 
ID and password, then click Logon.  Graphic screens can be viewed by the operator without 
logon, but many system configuration operations will not be available.

Mute
The Mute button will silence the alarm horn output.  Muting the alarm does not acknowledge 
it.  Acknowledgment must take place on the alarm screen.  See Alarms on page 5.

Screen 2
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Operational Overview
Signal Server Console View for PC-based control systems only
Click on the View button on Screen 2  to display the View menu (Screen 1).  Click on the 
Console button to display the Console Select window (Screen 3).  You can also access the 
Console Select window from the pull down menu by selecting Server > Console View > 
Open.  To view the details of your Signal Server system, select Your Installation Name and 
click OK.   This will take you to the main menu which gives access to system setup, control 
and monitoring features.

Screen 3

Q&A Library
The help details for the Signal Server Console View menus can be found by clicking the 
Q&A Library  button.

Editor
Click the Editor button to open the Text editor.  This gives you a convenient text editor for 
printing and saving text documents.

Graphics
Clicking the Graphic button will display your system’s main graphic start screen.  Click the 
down arrow to display a list of all the available graphic screens.  Click on the desired screen 
to go directly to that graphic.  Each screen is specific to your control system.  Click on various 
buttons to go to other areas, change setpoints and to turn on/off outputs.
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Operational Overview
Alarms
If an alarm occurs in the system, you will be notified with the specific server alarm message (small 
window on Screen 4).  Click the Acknowledge button to close the message window and display the 
Server Alarms window.  Clicking the Acknowledge Active Alarms button will silence the alarms and 
log the current user name in the Acknowledge column.  A yellow alarm will appear with the 
Condition Normal message after the signal is no longer in alarm.  To clear the alarm from the display, 
right click in the alarm window and select Purge To History.

Screen 4
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Viewing Historical Data
Signal Trending Screen
 Clicking the Trending button on the Econ toolbar will display the Signal Trending Screen 
5. The screen gives the operator the ability to view data list and trend graphs.  All analog 
data points for the system are stored to disk and may be viewed.   

Selecting Data for Display
The first step to displaying a data trend is to select the signal data to be displayed.  Click on a data 
column or select a column with the up/down arrow keys next to the column box.  Click on the browse 
button (binoculars) next to the Signal Name to display the signal data that is available for trending.  
Select the signal data point to be trended for the selected column.  Repeat the  steps for up to ten 
columns of data.  The group of signal data points may be saved to disk and then  recalled to display 
the group of data again in the future.  To save the defined data set, click the disk button, enter a name 
and click Save.  The data set can be opened in the future by clicking the folder button. 

Screen 5
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Viewing Historical Data
Acquire Recent History Data for Display 
After selecting the analog data to be trended, click the Acquire button to display the most recent 
historical data file (Screen 6).  

Screen 6

Export Historical Data to Excel
If you have MS Excel on your system, you can export the data directly to Excel.  Check the 
Show Export box to start Excel after the export.  Check the Email box to email the exported 

Excel file.

Print Historical Data Reports
Use the Print button to generate a report of the currently displayed data.  Once the report is 
displayed, you can right click on the report to send it to the printer or to save it as a text file.
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Viewing Historical Data
Import Archived Data for Display
Use the File button to import data that was stored prior to the data that was retrieved with the Acquire 
button.  This will display the History Data Selection window on Screen 7 above.  Select a file to 
import the historical data into the trend screen.  To select multiple files to be displayed sequentially, 
click to highlight the first file to be displayed and then Shift - click on the last file to be displayed.  
Click on the OK button to retrieve the selected files.

Screen 7

Saving Displayed Trend Data to Disk
The data set and the associated data shown on the trend screen may be saved as a group using the disk 
button.

Interval Skip
The Interval Skip box allows you to view the data at longer time  intervals than it was actually stored.  
For example, if the data was stored every 15 minutes and you select the Interval Skip of 1, then the 
data sample for every 30 minutes will be displayed.
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Viewing Historical Data
Graphical Line Trend Display 
Click the Trend Graph tab on the lower left side of the screen to display the line graph shown in 
Screen 8 .  Right click on the graph to display detailed graph viewing options.  The Historical Graph 
and Polar Graph types are also available for display.  Click the Data Set tab to return to the main 
screen.

Screen 8

Graphical Line Trend Display - Data Zoom
To zoom in on a specific data and time range, left click the mouse at the start point, drag to the 
stopping point and then release the left mouse button.  The graph will now display the selected details.  
To return to the display of the entire graph, right click on the graph and select Undo Zoom.
10



Viewing Historical Data
Graphical Line Trend Display - Detail Menu
Right clicking on the trend graph will display the trend Detail Menu.  Several options are available to 
customize the look of your trend graph.  The most useful features are discussed below. 

Graphical Line Trend Display - Mark Data Points
Right click anywhere on the white portion of the graph to display the menu shown on Screen 9.  
Selecting the Mark Data Points option will display the point on the graph that the data was recorded.  
Select the Mark Data Points option again to remove the marked points on the graph.

Screen 9
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Viewing Historical Data
Graphical Line Trend Display - View Data Point Value
While the Mark Data Points option is checked, you can use the mouse to click on a specific data point 
to display the stored value.

Screen 10
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Viewing Historical Data
Graphical Line Trend Display - Include Data Labels
To show the line graph with the data point labels displayed (Screen 11), right click on the graph to 
display the pop up menu as on Screen 9.  Select the Include Data Labels option.  Select the Include 
Data Labels again to remove the labels.

Screen 11
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Viewing Historical Data
Graphical Line Trend Display - Printing and Saving 
Once you have the desired graph area displayed on the screen, right click anywhere on the white 
portion of the graph to display the menu shown on Screen 9.  Selecting the Export Dialog will display 
Screen 12.  Check the Printer as the Export Destination.   The Print button will appear.  Click the 
Print button to send the currently displayed trend graph to the printer.  The graph can also be sent to 
the Clipboard to be copied to another application or saved to disk as  a Text file, a .BMP graphic or 
MetaFile.

Screen 12
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System Configuation
Logon for System Configuration
Authorized users must logon to the system to access system configuration menu options.  If you are 
not currently logged on, then click Server > Logon  from the main menu.  Enter your User Number, 
User ID and password, then click Logon.
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System Configuation
Signal Server Console View Configuration and Additions
Click on the Console button to display the Console Select window (Screen 13 ).  You can 
also access the Console Select window from the pull down menu by selecting Server > 
Console View > Open.

Screen 13

To modify the communication parameters, click on the Edit button on Screen 13.  Your setup 
should be similar to the one in Screen 14.  The Baud Rate, Port and User information may vary.  To 
setup a new configuration for a different user or a dial up connection, click Cancel.  From the pull-
down menu bar, select Server > Console View > New.  Screen 14 will be displayed  without the 
configuration information.  Fill in the data for your new connection.

Screen 14
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System Configuation
Signal Server Console View Modem Configuration 
To setup a modem connection for remote access, check the box next to Modem Connection on the 
Console Communications Setup Screen 14.  Click the Modem button to display the Modem 
Information window on Screen 15.  Click the Default button to fill in the setup default shown 
above.  Your modem settings may vary from the ones shown above.  If you already have a modem 
connection that is configured, you should use the same settings for each connections.  Consult your 
modem manufacturer’s information if the settings do not work correctly.  Click OK to accept the 
changes or Cancel to leave unchanged.

Screen 15
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System Configuation
Telephone Number Setup
After setting up the modem, click the Telco button to setup the modem dialing sequence.  The Telco 
Connect Number is the number of the system to dial to.  The remaining items may be left blank if 
they are not necessary for your location.  Enter any required dial out access numbers in the Out Line 
Access box.  To dial a long distance access number, enter it in the LD Carrier Access box along with 
a delay (in seconds) time before dialing the phone number.  An extension may be entered with an 
Ext. Delay  time between dialing the phone number and dialing the extension number.  Any calling 
card numbers will be Pre Delay to pause before the calling card number is dialed.

Screen 16
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System Configuation
Project Archive
The windows system file my be backed up into compressed file format (.zip).  From the pull down 
menu bar, select Utilities > Project Archive to display the Screen 17.  First, you must enter a path.  
You can type the path in or use the binoculars to browse for the directory used to store the archived 
files.  Group as Multiple Files.  The Single File button is for future use.

Screen 17
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System Configuation
Edit Graphic Screen Bitmap
To edit or add static or background graphics to a screen, display the screen to be edited using the 
system screen select buttons or click Server > Graphics > Edit from the main menu.  You must be 
logged on to perform screen edits.  Once the desired screen is selected, right click on an empty area 
and select Edit Bitmap. This will launch the Paint bitmap editor with the current screen ready for 
edit.  When you have completed the edits, save the screen from the editor or exit without saving to 
cancel changes.

Screen 18
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System Configuation
Graphic Tools - Creating and Editing Graphic Objects and Text
To edit and add animated graphics or text to a screen, you must be logged on to the system.  Once 
the desired operator screen is selected, right click on an empty area and select Edit Screen. This will 
display your Graphic Tool window Screen 19.  When you have completed the edits, save the screen 
by clicking the disk button.  To exit the Graphic Tool window, right click on an empty area of the 
screen and select Control Mode.

To cancel the edits made on the screen, do not click the disk button.  Exit the graphic editor and exit 
the operator screen.  You will be prompted to Save Change.  Click No to cancel all graphic edits.

Screen 19  

Graphic Tools - General
The Save Graphic Edits button saves your edits before you exit the Edit Mode.

Use the Cancel Current Operation button to cancel the graphic insert mode.

Click the Delete Item button and then click a graphic item to delete the item.

Click the Move Item button to move a graphic or real time text value and then click once on 
the item to be moved.  The item begins to drag with the cursor.  Position the item in its new 
location and click again to drop it.  Moving analog and signal data text will require three 
clicks.  The first click is for the data, the second is for the description and the third is for the 
engineering units.  

Use the Show/Hide Hot Areas button to toggle the hot area locations from invisible to 
visible.  The hot area of a graphic is the area on the screen that will respond to mouse 
operations or display data while the screen is in the control mode.

Click the Delete Item button and then click a graphic item to delete the item.
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System Configuation
Graphic Tools - Copying Graphics Objects 
The easiest way to create a new object is to copy an existing object from the current screen or even 
from another screen.  This will copy all of the current graphic properties such as font size, and color 
for the descriptions, values and engineering units.  After copying a graphic or creating a new 
graphic with the graphic tool, you may edit its graphic properties (see page 26).  For example, you 
may want the same look for a different analog value.  

Select Cut or Copy, then click the desired graphic.  If graphics overlap, you will be given a 
list to choose from.  A cut or copied graphic will remain in the paste buffer until it is replaced 
by another cut or copy.  When you Paste the graphic you will be asked if you want to “Paste 
in Original Position”.  This feature is useful for duplicating similar graphic properties on a 
different screen.  Answering No will allow you to position the graphic anywhere on the 
screen.  Once you paste a graphic, you can change its properties to display a different data 
item (see Graphic Properties - Data Tab on page 26).  

Graphic Tools - Creating New Graphics
From the Graphic Tools (Screen 19) window, click the desired button to add a new graphic object.  
After the object has been placed on the screen, you may click on the object to edit its graphic 
properties.  The details for editing the graphic properties are found in Graphic Properties on page 
25.

Use the Analog Value button to place a new analog data value on the screen.  Click the button 
and the Analog Database will be displayed.  Click on the desired data item and then click the 
select button.  The description will begin to float on the screen.  Drag it to the desired location 
and click once to drop it on the screen.  Repeat the process for the data value and engineering 
units.  To change the properties, click the data item to display the Graphic Properties Editor.  

The Digital Value button will place a digital signal data point status indicator on the screen.  
The status will be a text message indicating on or off.  Click the button and the Signal 
Database will be displayed.  Click on the desired data item and then click the select button.  
The description will begin to float on the screen.  Drag it to the desired location and click 
once to drop it on the screen.  Repeat the process for the data value. 

The Level Fill button allows you to add a dynamic bar graph that will correspond to an 
analog data value.  It displays the graph for a data range from 0 to 100.  Clicking on the 
button will display the Analog Database Selection window.  Click the desired data point and 
then click the select button.  Position the cursor at the location of the top left corner of the bar 
graph.  Click, hold and drag the box to the low right corner of the bar graph and release.  Edit 
the description color to change the color of the bar on the graph.  See Graphic Properties - 
Description Tab on page 25.
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System Configuation
Use the Hot Button button to create a new button area for the operator to select graphic 
screens.  Position the cursor at the location of the top left corner of the button area.  Click, 
hold and drag the box to the low right corner of the button area and release.  See the Graphic 
Properties - Description Tab on page 25 and the Graphic Properties - Button Area Tab on 
page 28 to configure the button properties.

The Application button allows the user to start embedded applications.  Click the button and 
select an applicaton from the menu.  Position the cursor at the location of the top left corner 
of the button area.  Click, hold and drag the box to the low right corner of the button area and 
release.  The available applications depend on your specific application.

The Alarm Acknowledge button creates a button area that will acknowledge all active 
alarms without having to open the Server Alarm window.  

The Console Connection will add a button to the operator screen that will display the 
Console View - Engineering System window if you are using a standard PC based control 
system.

The Trend Select button will add a button to the screen that will allow the operator to 
display a real time trend for one analog data point.  Click on the button to display the Analog 
Database Selection window.  Click the desired analog data point and then click select.  Drag 
the button to the desired location and click to drop it.  The button can be set up so that the 
operator can select any analog point to display after he clicks the button.  To set the button 
up with the operator select configuration, add a Trend Select button with any data point and 
then edit the Selector ID on the Graphic Properties - Data Tab on page 26 to equal 0.

Graphic Tools - Library Tab
Select the Library tab at the top left on the Graphic Tools window (Screen 19 ).  This will take you 
to the Automation Library tools.  Use the up and down arrow keys to scroll through the available 
library elements.   

Use the Select Library Object button to insert the displayed library element or the screen.
24



System Configuation
Graphic Properties 
Graphic Properties can be edited by clicking on a graphic’s hot area while in the Edit Screen mode.  
This will display the Graphic Properties Editor Screen 20.  Select a tab to modify the current 
properties.  Once the changes have been made to the editor, you must click the Update button or 
hit the Enter key to accept the changes.  Click the close button to exit the Graphic Properties 
Editor.  

The Line and Column items indicate the location of the data on the screen in pixels.  Changing these 
values will move the location of the text description.   The Print Color button and the A will change 
the descriptions color and font type.  These attributes are used for the Description, Data and 
Engineering Units tabs.

Hint:  Once you have made the desired changes to the graphic, you may select another graphic’s hot 
area without closing the Graphic Properties Editor.  Be sure to click the Update button or hit the 
Enter key before you do this or your changes will not be saved.

Graphic Properties - Description Tab
The Description Data box (Screen 20) contains the description that is displayed with digital or 
analog text values.  Placing the @ symbol in front of the description will make the description 
invisible.  

Screen 20
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System Configuation
Graphic Properties - Data Tab
Click on the Data tab to display Screen 21 .  To change the graphics current Data Item, click on the 
browse button next to the Selector ID.  The Signal or Analog Database Selection window will be 
displayed and allow the selection of a new Data Item. 

Screen 21

The Print Fmt entries indicate the number of digits to the left and right of the decimal point.  Screen 
21 indicates that the data will be displayed with 2 digits to the right of the decimal point. 

When the Data Item is a digital signal point, the Active Desc and Inactive Desc item will contain the 
on and off description for the current state of the data point.  This allows specific descriptions like 
running/stopped or open/closed etc. to be used.

The Select Type options control the access that an operator has to make changes to a data item and 
its current value while it is displayed in the control mode.  The item is accessed from the screen 
when the operator clicks on the Hot Area for the item.  Select None for no operator access.  Select 
Simple to allow the operator to change the current value of the analog or digital signal data.  Select 
Full to take operator directly to the Signal Database window.

Warning:  Changing the Line and Column position will not move the hot area.  This will cause text 
to be written to but never cleared.  Use the Graphic Properties - Button Area Tab on page 28 to 
move the hot area along with the data move.
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System Configuation
Graphic Properties - Engineering Units Tab
Select the Engineer Units tab to edit the Data Item’s engineering unit text properties.  The Hide 
Engineering Units check box will allow the data to be displayed without the engineering units.  

Screen 22
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System Configuation
Graphic Properties - Button Area Tab

The Button Area is the hot area that the operator clicks on to edit the signal data, view another 
graphic screen or start an application.  Use the Show/Hide Hot Areas button on the Graphic Tools 
window (Screen 19) to display the active button areas.  Use the Top Left and Bottom Right, Line and 
Col entries to edit the corners of the button area or change the Height and Width.  Using the arrow 
keys to make the change will instantly update any corresponding dimension.  Use the Position 
arrows keys to move the button without changing the dimensions.

Screen 23

The Button Type is set when the button is created from the Graphic Tools Window and should not be 
changed.

The Name is the screen to be displayed when the operator clicks the button area to open a new 
screen window.  The screen name can be selected with the browse button or entered directly.

The Close View On Press is used when the button displays a new screen.  Select the box to close the 
current screen window when the new window is opened.  

The Invisible check box will remove the red button area and the description from the screen.  This 
allows you to make a custom button on the background screen with the bitmap editor.  
28



System Configuation
Screen 24  Graphic Library Editor - Movie Type 

Graphic Library Editor - Overview of Graphic Animations
Animated graphics including moving objects, selector switches, push buttons and pilot lights can be 
created and edited using the Graphic Library Editor Screen 24.  Access the editor from the pull 
down menu, by selecting  Application > Graphic Library Editor.  Use the left and right arrow 
buttons to the right of the Library ID to scroll through the existing graphics or to find a blank 
Library ID for a new graphic.  The arrows to the right of the Frame number select the different 
graphics for the current Library ID that will be displayed based on the value of assigned signal data.  
See Graphic Properties - Data Tab on page 26.  

The box to the left of the Browse button (binoculars), indicates the name of the bitmap source file 
for the currently displayed graphic Frame.  To edit the existing bitmap source file, click the Edit 
button.  This will start the bitmap editor.  Saving the graphic in the bitmap editor will replace the 
currently displayed Frame.  To select a different bitmap source file, click the browse button 
(binoculars) and choose the new bitmap file.

Note:  The bitmap files for each frame of library items must have the same width and height 
dimensions.  The dimensions are indicated by W= and H= box to the left of the OK button.  The 
width and height are determined by the first bitmap that is selected for a new Library ID.  To insure 
that the second bitmap graphic is the same size, first select Frame 1, then edit the graphic and save 
it as a new graphic.  Select this new graphic for Frame 2.  The only way to change the dimensions is 
to delete the existing library item and select a new bitmap.

To delete a library item, right click on the Graphic Library Editor window and click Delete Item.
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Click the OK button to accept the edits made to the Graphic Library Editor or choose Cancel to 
abort the edits without saving.  Any edits to bitmap files that were saved, will not be effected by 
clicking the Cancel button on the Graphic Library Editor window.

You can create graphics that are not rectangular and contain areas on the graphics that allow the 
background screen to show through.  When you create the graphic with the bitmap editor, select a 
color to be transparent and fill all the areas on the graphic that you want to be transparent with this 
same color.  Once the graphic is displayed in the Graphic Library Editor, click the Eye Dropper 
button-   then place the tip of the dropper over the color that you want to make transparent and 
click again.  To eliminate the transparent color, click the Eraser button- .

Graphic Library Editor - New Graphic Items
To add a new graphic item to the library, you must first create the graphic bitmaps to be used.  New 
graphic bitmap can be created using any bitmap editor.  To use Paint, click the Windows Start button 
> Programs > Accessories > Paint.  Draw the graphic and then save it using a name with eight 
characters or less.  Draw and save the cooresponding graphics which will represent motion or an on/
off status.  Remember to make all of the bitmap graphics the same size by modifying the first 
bitmap and saving it with a new name.  Return to the Graphic Library Editor and use the Library ID 
arrows to select a blank library item.  With the first Frame selected, click on the browse button 
(binoculars) and select the name of the bitmap graphic that represents the first status condition.  
Click the right arrow to select the next Frame and use the browse button again to insert the next 
graphic.  Check the buttons for the desired Graphic Type and Frame Type.  Reference the specific 
details of the graphic type below to complete the graphic creation process.

Graphic Library Editor - Movie
Graphic items with the Movie button checked will scroll through up to six graphic frames to create 
a graphical animation or movie Screen 24.  The animation is in motion when the assigned data 
signal is active.  The speed that the movie is played can be controlled with the Frame Speed arrow 
buttons.  A higher number will slow the speed of the animated motion.

Graphic Library Editor - Toggle
Check the Toggle button Screen 24 to create a graphic that will turn a data signal on and off when 
the operator clicks anywhere on the graphic.  Graphic Frames 1 and 2 display the on and off state of 
the data signal.  Check the On button for the frame that you want to display in the on state then 
select the other frame and check the Off button for the frame you want to display in the off state.
30



System Configuation
Screen 25 ON/OFF Operation, Off position

Graphic Library Editor - ON/OFF Operation
Click the ON/OFF Operation button to create an ON/OFF control button of a signal data point 
(Screen 25).  Clicking the Horizontal button enables the operator to turn the signal off and on by 
clicking on the left and right half of the graphic.  With the Horizontal button selected as the 
Orientation, the Frame 1 graphic will be displayed when the operator clicks on the left half of the 
graphic.  At the same time,  the Frame 1 selected Frame Type condition (Off as shown on Screen 
25) becomes active for the signal data.
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Screen 26 ON/OFF Operation, On position

If the operator clicks on the right half of the screen graphic, then the Frame 2 graphic is displayed 
and the Frame 2 selected Frame Type condition (On as shown on Screen 26) becomes active for the 
signal data.  

Clicking the Vertical button will change the active areas on the graphic.  The operator can now click 
on the top and bottom of the graphic to change the signal data and displayed graphic.  When the 
operator clicks the top half of the graphic,  the Frame 1 graphic of the library element is displayed 
and the selected Frame Type condition is set for the signal data.  
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Screen 27  MOA Operation

Graphic Library Editor - MOA Operation
Click the MOA Operation button for Manual On - Off - Automatic control type selector switch 
Screen 27.  Use Frames 1,2 and 3 then check appropriate Frame Type for the corresponding 
graphic.  Screen 27 shows the Auto button checked for the Auto position of the selector switch 
graphic.  When the graphic for Frame 1 is displayed on the operator’s screen, clicking on the right 
half of the graphic will display the graphic and set the corresponding signal data value for Frame 2.  
While the Frame 2 graphic is displayed, the operator can choose to click the left half of the graphic 
to return to Frame 1 or click on the right side to display the Frame 3 graphic.  Again, the 
corresponding signal data values will be set when the graphic is displayed.  The value sent to the 
controlled signal data is 0 for Off, 1 for On and 2 Automatic. 

Graphic Library Editor - ON/OFF Status Image
Click the ON/OFF Status Image to display a graphic to indicate when a signal data point is on and 
off.   Select the graphic that represents the “ON” state on the data signal in Frame 1 then check the 
On button for the Frame Type.  Use Frame 2 to display the “OFF” state on the data signal.  Select 
the corresponding graphic and check the Off button for the Frame Type.
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Graphic Library Editor - Status Image
Click the Status Image button to swap up to six different graphics based on a single data signal.  The 
Frame 1 graphic will be displayed when the analog signal data is equal to 1.  The Frame 2 graphic 
will be displayed when the analog signal data is equal to 2 etc.  This could be useful to indicate 
multiple states, colors or positions of the automated equipment.
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